
 

 
 

Paratext Project Sharing Manual 
This document is a manual for setting up Project Sharing (Send/Receive) for a project 
using Paratext 9.(9.0 or 9.1). To implement these instructions, every project user can 
be running either Paratext 8 or 9 or Paratext Lite using their own unique 
Registration details, but the project administrator must be using Paratext 9. While 
the basic principles of how Send/Receive works are the same for Paratext 8 and 9, 
only detailed instructions will be given for Paratext 9. 

1. Introduction 
1.1. What is a project repository? 
1.2. What does it mean to Send/Receive a project? 
1.3. What are project-sharing roles? 
1.4. What is a merge conflict? 

2. Initial Project Sharing (Send/Receive) Setup 
2.1. Things to consider before enabling project-sharing 
2.2. The project-sharing setup process 
2.3. Initial Send/Receive for other team members 
2.4. Editing in a shared project 

3. Ongoing Send and Receive Operation 
3.1. Send/Receive button on the toolbar 
3.2. Send/Receive from project menu 
3.3. Scheduling automatic Send/Receives 
3.4. Send/Receive best practices 
3.5. Tips for using Send/Receive successfully 

4. Reviewing Text Changes 
4.1. Compare Version feature 
4.2. View History for Verse(s) feature 
4.3. View Project History feature 
4.4. Review recent changes feature 
4.5. Handling merge conflicts 

5. Send/Receive Maintenance 
5.1. What project data is being shared by Send/Receive? 
5.2. What project data is not shared by Send/Receive? 
5.3. Who can make changes to different types of project data? 
5.4. Understanding the flow of changes 
5.5. Managing project users 

6. Troubleshooting 
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6.1. How do I fix a corrupted project text? 
6.2. How do I restore a project on a repaired computer or put it on a new computer? 
6.3. I have poor quality Internet connection. Can I still use Send/Receive? 
6.4. Can I use other synchronization software and Paratext Send/Receive together 
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1.Introduction 
Paratext 9 enables project teams to easily and safely share project data using a feature called 
Send/Receive. This maintains a detailed history of all the changes being made to a user's project files 
inside a special (hidden) container called a repository.  Inside the repository, Paratext keeps track of 
changes made to every project file. Each user has a copy of the repository. 

The Paratext Send/Receive functions transmit and merge project repositories between team 
members, so that changes made by different users are merged together. This allows users to work 
independently, but then also be able to contribute work back to the rest of the team at any time. Send 
and receive can be done to the internet server, or between users using a USB drive, a network shared 
folder, or SIL Chorus Hub software. 

In Paratext 9 we have worked hard to provide an easy-to-use interface for managing and using project 
sharing functions. Nonetheless, it is essential that the details in this introduction and the instructions 
for setting up project sharing are read and understood thoroughly before implementation. 

 1.1. What is a project repository? 
A project repository: 

● stores the editing history of a project in Paratext.  

● is stored locally in the “.hg” sub-folder of each project on your computer. This folder should 
never be removed, or manually modified in any way. 

● is also stored in a shared location to merge the work of multiple users via the internet 
server, a USB drive, SIL chorus hub, or a network shared folder.  

● serves as a backup of the project data so that if the local repository gets corrupted, it can 
be recovered from any other valid repository of that project.  

1.2. What does it mean to Send/Receive a project? 
A Send operation sends the latest changes1 you have made on your computer to another repository 
on a USB key, a network shared folder, or the Internet server.  

A Receive operation gathers up the latest changes others have made and duplicates them in your 
repository and project files. A Send/Receive operation performs a Receive first, and then a Send. 

1.3. What are project-sharing roles? 
Paratext users have one of four different roles on a project that define what they can do.  
 

1 Most Send/Receives send a relatively small amount of data, since only the changes are sent back and forth 
with the server.  The exception to this is the very first Send/Receive, which is when Paratext has to send the 
complete project. 
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Observer: Can receive and view the project but cannot make any changes. 

Consultant/Reviewer/ 

Archivist/Typesetter: 

Can receive and view the project. Can add non-publishable notes to the 
project to indicate issues that need attention. 



 

 Every project must have at least one Administrator. The Administrator role is 
essential for initial project sharing setup. A more detailed description of this role will 
be outlined later in this manual. 

1.4. What is a merge conflict? 
Since Paratext permits several people to work on the same project, a conflict can occur if two users 
were to make different changes to the same verse at the same time. It is simple for the software to 
merge changes when one user revises John 19 and 20 and another user drafts Acts 1. But if one user 
updates the spelling of “Pentecost” in Acts 2:1 and another user adds a clause to that same verse to 
sound more natural, the software cannot merge these changes automatically. 

Paratext has a variety of ways to prevent different 
users from editing the same verse. Tasks in the 
project plan that enable editing can only be 
assigned to one user. However, as in the 
example above, tasks like spell checking are 
global and span all available books. 
Administrators should use great care to not 
configure their project plans to allow one team 
member to edit the text at the same time a 
different team member is doing spell checking, 
parallel passages check or other tasks that could 
make changes to multiple books.  

The same care needs to be taken if an 
administrator is manually assigning editing permissions. He needs to be constantly aware of the 
potential danger for conflicts that global tasks have. Additionally, administrators should not assign the 
same book or chapter to more than one person. Most conflicts are caused this way.  If an 
administrator does this, they will see red text in the permissions dialog box. For more information on 
manually setting permissions see the Project Sharing Manual Appendix or read about permissions in 
Paratext Help 

If two team members work on the same verse at the same time, Paratext will discover this during the 
next Send/Receive.  Paratext then will create a special note at that point in the text, so that the 
administrator or a translator who has editing permission for the book can resolve the issue. Below is 
an example of a conflict note flag. How to resolve merge conflicts will be discussed in section 4.5 
 Handling merge conflicts 
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Translator: Can receive and view the project. Can add non-publishable notes to the 
project. Can alter the text of any books in the project which have been 
assigned to them by an Administrator. 

Administrator: Can do anything a translator or consultant can. Is responsible for project 
creation and configuration, assigning roles to each user, assigning tasks 
that require editing to individual translators. Is commonly responsible for 
reviewing the changes made by other users and for resolving any merge 
conflicts which may arise. 

https://docs.google.com/document/u/0/d/1n2NTQGq0gzHM34Qd2JYpX9hwV5rVacRUtk1m5WMH1y4/edit


 

 It is important to do Send/Receives frequently enough to eliminate merge conflict 
errors. If translator “A” finishes editing a verse but does not do a Send/Receive 
before translator “B” starts editing the same verse, then a merge conflict is likely to 
be produced.  For more information on recommended Send/Receive procedures 
see : 3.4 Send/Receive best practices and 3.5 Tips for using Send/Receive 
successfully. 

2. Initial Project-Sharing (Send/Receive) Setup 
Note: Sharing works fine between Paratext 8 and 9 users. This means it is possible 

that some members on a team have Paratext 8 and others have Paratext 9. There 
are two limitations on mixing Paratext 9 and 8 on the same project. The first is in 
the creating or modifying of a Project Plan. Only Project Plans that are applied to a 
project in Paratext 9 will have all of the Project Plan features. It is therefore strongly 
recommended that project administrators have Paratext 9.The second limitation is 
that Paratext 9 is fully compatible with the USFM3 standard, while Paratext 8 is not. 
Early versions of Paratext cannot open an USFM3 project, and later versions of 
Paratext 8 can open such projects but may not be able to display them correctly.2  

2.1. Things to consider before enabling project-sharing 
Project sharing configuration involves assigning one Administrator, plus one or more additional users 
who are assigned other roles in the project, such as "Translator", 
"Consultant/Reviewer/Archivist/Typesetter", or "Observer".  

The person who will be the Administrator should create the project. In the New Project dialog, the 
administrator can enter the desired project name and short name, enter the language information, and 
specify which books are within the scope of the project. The administrator should also register the 
project with the Project registry. There is a button on the Project Properties dialog that gives you a 
shortcut to the page for registering a project. Project Registration is required to be able to 
send/receive the project over the Internet. Unregistered projects can use send/receive to USB drives 
or network folders. 

The administrator should also set up the project plan. The project plan defines the tasks involved in 
working on a translation and enables editing permissions to be adjusted as project members finish 
one task, enabling the next task to begin. There are a number of base plans available with the tasks in 
a translation already defined, that you can adapt, and modify if needed. See this link for more info on 
Project Plans. 

The administrator can then add users and define their roles. This is done in the User Permissions 
dialog, within Project settings. When you first open User permissions, Paratext asks you to verify 
these four criteria: 

1) Are you the Administrator? (Yes or No) 

2 Versions of Paratext 8 before version 8.0.100.76 cannot open projects that are using USFM3 stylesheet. If a 
team needs to use USFM3 stylesheet then all team members should have at least version 8.0.100.76, but 
ideally, everyone should be using Paratext 9.0 or later.  
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2) Do you have the most up-to-date and authoritative copy of your text on your machine? 
(Yes or No) 

3) Do you have the Paratext Registration Names for the people you want to share your 
project with?  (Yes or No) 

4) Have you received training on project sharing?  (Yes or No) 

 

Go and do what is required until you can answer yes to all four questions.  Note: Reading and 
understanding this manual will satisfy question number four. 

 
2.2. The project-sharing setup process 

1. Open or create the project you want to share.  

(You can read about creating a project by looking up “How do I create a new project?” in Help.) 

2. Click on the Project Menu of your project. 

 

3. Go to Project Settings  Users Settings and click on that. 
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The Users Setup dialogue will open. Check all the questions that are true for you. The OK 
button will remain greyed out until all four boxes have been checked off. Go and do what is 
required until you can answer yes to all four questions.  (Note: Reading and understanding 
this manual will satisfy question number four.)

 

What these mean: 

● The administrator is the one who defines users and permissions, so it should be the 
administrator who is setting this up. 

● For a new project, this issue is not relevant. But if work has been begun on translation 
in other documents, or in earlier versions of Paratext, it is important to start the shared 
project with the best version of the text. Taking the time to gather the best version of 
the data into one place before sharing the project is essential. See appendix for more 
details. 

● To add users, you need their registration names. If someone does not remember the 
exact form of their registration name, they can check it in their copy of Paratext by 
displaying the registration info dialog, or the “About Paratext” image. Paratext has a 
limited ability to find a similar name if you do not get the spelling exactly right. 

● There are several potential pitfalls in working in a shared project and we want to be 
sure users are informed how to avoid these. Reading through this manual is a good 
start on learning about send/receive. More information is available in Paratext help and 
in the training videos. Explaining Send-Receive, Receiving for the first time, Ongoing 
send-receive, Merge conflict notes  

 

4. When you are able to check these four boxes the OK button will turn black.  Click OK to 
continue. The next User permission dialogue will open. You will see your name in the user 
list as administrator.  
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Adding a User 
5. To add a person to share the project, click Add User. The Add User dialogue will open. 

6. Enter the user's Paratext Registration Name, and click OK to continue. 

 

● If you misspell the name or the user does not have a Paratext license, then Paratext will 
search the worldwide list of Paratext users and suggest the name of an existing Paratext 
user that most closely matches the name that you typed. 

 

7. Repeat the process to add any other team members.  Note: You can add other members 
at any time, so will always be able to add new people to your shared project. 

Changing a User’s Role 

8. Beside each user's name, click Change Role. Then select their role within the project from 
the pop-up list: 
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9. When you have finished adding users to the project, click OK to close the User 
Permissions dialog to continue.  Paratext will update Registry (if you have an Internet 
connection). 

Then it will give you a message saying that you must do a Send and Receive. 

10. Click OK to continue. Paratext will bring up the send/receive projects dialog with your 
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project already checked. 

11. Click the Send/Receive button to send the users and roles to the Paratext server.  

Note: Doing a Send/Receive now will not assign editing permissions to any books or 
chapters. The administrator will need to assign tasks via the Project plan later. (See 
the Sharing Manual Appendix or training videos for more details 
https://paratext.org/support/learning/project-plans/)  
The Changes Sent and Received dialogue will open when the operation is completed. 

12. Click Close to continue. 

2.3.  Initial Send/Receive for the other team members 
If you, the administrator did not complete a Send/Receive with the Paratext server as described in the 
steps above, or you wish to share your project to another location to an USB thumb drive follow the 
steps below.  If you are a translator or have a role other than administrator  then skip down to the 
section Translators, observers, consultants and others Receiving a project for the first time 

   On the Administrator’s computer: 

To do the initial send/receive, go to the main Paratext menu, and click on the Send/Receive 
Projects command. (There are other ways to initiate a Send and Receive operation that will 
be described later in this manual.) 
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The Send/Receive Projects dialogue will open 

In the top part of the dialog you choose your send/receive destination. Only those destinations 
available will be active and available to be selected. For instance, using a USB thumb drive for doing 
Send/Receive within an office is very common.  The USB drive must be inserted into the computer 
before starting the Send/Receive process. See the descriptions below if you need more information on 
each possible location for your project’s repository. 

1. Click one of the buttons beside Internet Server, USB Drive, Chorus Hub or 
Network Shared Folder in the "Send/Receive With" section 
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Internet Server: Share the project using a UBS-managed Internet server. A stable connection 
is required in order to successfully use this option. 



 
2. The project should already be selected; if not select, the project or projects you wish to send 

and receive. 
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USB Drive: Share the project using a USB drive. The USB drive will be physically 
circulated and plugged in to each user’s computer, and each person will 
perform a Send/Receive operation to this same drive. After you select this 
option, select the appropriate drive letter from the drop-down list of USB 
drives attached to your computer. A folder named "Shared Paratext Projects" 
will be created on the selected drive, if it does not already exist. In order to 
choose this option, the USB drive has to be in your computer when you open 
the send/receive dialog.  

Network Shared 
Folder: 

Share the project using a storage location on your local network, which is 
accessible to each user. After you select this option, browse to the correct 
location on your network (it might be helpful to map this location to a drive 
letter.) A folder named "Shared Paratext Projects" will be created at the 
selected location, if it does not already exist. (Warning:  Do not set up a 
shared folder on a streaming service such as Google Drive, One 
Drive, or Dropbox.  These services have their own means of 
synchronizing the data on your computer and on their servers and 
will conflict with Paratext’s merging efforts.) 

Chorus Hub Chorus Hub is a SIL software program that sets up something like a 
shared network folder on one computer that other computers on the same 
network can connect to. See https://software.sil.org/chorushub/  

https://software.sil.org/chorushub/


3. Click Send/Receive. 
Paratext will display a progress dialog while the data for the project is initially sent to 
the sharing device. This will make the project accessible to the other users that have 
been added. When it finishes, Paratext should inform you of the result. 

4. Click on Close to continue. 

Inform team members they should now do a Send/Receive to download the project 
onto their computers. You will need to tell them which location they should use 
(Internet, USB drive, Chorus Hub, or Network shared folder).  

 
 Translators, observers, consultants and others receiving a project for the 

first time 

1. If you have any role other than administrator and the project administrator has informed 
you that the project is ready for you to download, you will need to do a Send/Receive with 
the sharing device specified by the administrator. (Note: In cases where there are multiple 
administrators, the other administrator(s) who did not create the project will follow this 
procedure as well.) 

2.  Go to the main Paratext menu, and click on the Send/Receive Projects command.  

3. The Send/Receive Projects dialogue will open. 
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4. Click on the location of the project you wish to receive. There are four choices: Internet 
server, USB, network folder or Chorus Hub.  (Your administrator will need to tell which 
destination to use.) 

5. Check the box for the project you wish to receive. A project you do not have will be labeled 
“New” since it is new to your Paratext. Be aware that if you have many projects in Paratext, 
the “new” projects appear at the bottom of your list in the Send/Receive Projects dialogue. 

If the list of Projects to Send/Receive is empty, it means that no projects are being shared 
with you using the selected sharing device. An Administrator would need to add you as a user in 
the project by configuring Users Permissions for the project and performing a Send/Receive to 
the sharing device. It could also mean you selected the wrong location for the project. 

 

6. Click Send/Receive. 

Paratext will display a progress dialog while the data for the project is being received from the sharing 
device. Then it will give a report dialogue informing you that the project has been downloaded in its 
entirety. 

 

Back to the top 

Paratext 8/9 Project Sharing Manual - v 1.0 - October 2020 

Page: 14 



 

5. Click Close to continue  
2.4.   Editing in a shared project 

When you are in a book or chapter where you have permission to edit, Paratext will display 
“(editable)” in the project title bar. 

 

 

In a book or chapter where you do not have permission to edit, “(Editable)” will not be shown.  
 

 

If you do not have editing permission, then ask your administrator to give you editing permission using 
either the project plan (recommended method), or through the User Permissions menu (not 
recommended method). 
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3. Ongoing Send and Receive Operations 
After the initial project sharing setup is complete, it is important to do Send/Receives regularly.  How 
often you should do Send/Receives will be discussed below in section 3.4 Send/Receive Best 
Practices.   When you are ready to do a Send/Receive, you can do it from the main menu as 
described in section 2.3 Initial Send and Receive for other Team Members.  Besides working from the 
main menu, there are three other ways to do a Send/Receive. 

3.1. Send/Receive button on the toolbar 
You can send and receive further changes to shared projects on your computer by clicking on the 
Send/Receive toolbar button,  
 

 

This will repeat the last send/receive action you took, sending and receiving the same projects with 
the same destination. If you need to change to a different destination, or change your selection of 
projects, you can open the regular send/receive dialog from the main menu, where you can choose a 
different destination and check or uncheck projects to send/receive. This procedure was described 
earlier in this document in the Initial Send and Receive section. 

3.2. Send/Receive from project menu 
Another option in Paratext 9, from any shared project menu, you can choose Send/receive this 
project. This will perform a send/receive of that project to the destination you last used.  

 

Open the Main project menu: 
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Click Send/Receive this project and Paratext will send and receive your project without requiring you 
to click on anything else. 

 

3.3. Scheduling automatic Send/Receives 
It is possible to configure Paratext to do Send/Receives automatically. 

The choices are: 

1) Never 

2) On Startup/Shutdown 

3) Hourly 

4) Every 4 hours 

5) Daily 

 

1. To configure scheduling, go to the main Paratext menu, and click on the Send/Receive 
Projects command.  
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2. Click on the Schedule button. 

 

3. Click on the drop down arrow for the project you want to schedule. 

 

4. Click on the frequency of Send/Receives you want.  On Startup/Shutdown is 
recommended for most teams. This setting will automatically do a Send/Receive for you 
when you start Paratext and again when you shut down Paratext.  
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Set your schedule to be more frequent than this if your team is making a large number of edits or if 
you are having merge conflicts when you do a Send/Receive. 
 

5. Click on OK to continue. 
 

 

6. The Send/Receive scheduler will now perform Send/Receives for you automatically 
according to the schedule you have set. 

Note:  Your computer will need to be connected to the Internet when the time comes 
for Paratext to do an automatic Send/Receive.  Paratext is not able to establish an 
Internet connection on its own. You need to do this for Paratext.  

3.4. Send/Receive best practices 
Below are some minimum best practices that will help you and your team get the most benefit from 
Send/Receive.  Following these practices will help you to avoid lost data, and merge conflicts. 
Additionally, if your team is using a project plan, your team will work more efficiently since editing 
privileges will be passed to team members as soon as they need them. 

 

● Send/Receive every time you work on the text: at the beginning and end of every working 
session as a minimum. Every team member needs to do this to share his or her changes with 
the rest of the team. 

● If you are using a Project Plan, do a Send/Receive after every completed task if possible. This 
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way team members waiting on you to finish a task will be able to start their task(s) sooner. 
Note: you may need to inform the other team member to do a Send/Receive in order to get 
your updated progress information. 

● When doing tasks that can involve making changes in multiple chapters or books, you should 
ask other team members to stop editing the project until you have finished.  These tasks 
include spell checking with the Wordlist tool or any other spell checking method, Biblical Terms 
renderings, Parallel Passages tool, or Find and Replace.  Once you have finished your task, 
then you should do a Send/Receive then each team member should do a Send/Receive.  The 
rest of the team should not resume editing the project until they have done a Send/Receive or 
else there may be merge conflicts when they eventually do do a Send/Receive. 

● Do Send/Receive more often during times when several team members are making large 
numbers of edits.  For example, many teams make more edits preparing for a translation 
consultant visit or a publication deadline.  At times like these consider doing Send/Receives 
more often. 

● If you or your team are having trouble remembering to do Send/Receives, use the 
Send/Receive scheduling feature.  (See the How to schedule Send/Receives section for 
details.) 

3.5. Tips for using Send/Receive successfully 
 1. Sharing one project to multiple destinations 

Some project teams have intermittent or expensive Internet.  In this situation a team should do the 
necessary Send/receives locally using a USB drive or shared folder, to keep the local computers 
up-to-date. Then, periodically do a Send/Receive using the Internet server, when a stable Internet 
connection is available. Often this can only be done in the evening when the number of people using 
the Internet is lower.  Consider using the Send and Receive scheduling feature to facilitate this. (See 
the section 3.3 Schedule automatic Send/Receives section for details.) Note: Care should be taken 
when using multiple USB flash drives or other destination devices, because the changes on those 
devices will remain there until they get shared with the computer that connects with the internet. 

 2. Consider Paratext Lite on an Android tablet or Smartphone 

If your team finds it necessary to travel to access a good Internet connection, then consider using an 
Android tablet or Smartphone for this.  Paratext Lite on many Android devices can do a Send/Receive 
over a local Wi-Fi network, micro SD card, or micro USB thumb drive.  (Caution: Not all Android 
Smartphones and tablets have USB ports that allow data transfer.  Many only support charging the 
device.)  Once you have the current version of your project on the smartphone or tablet, it can be 
taken to where the good Internet connection is and a Send/Receive with the Paratext server 
performed. (See the Project Sharing Manual Appendix for more details) 

3. Rounds of Send/Receive 

For larger teams who are having trouble keeping the projects on all the computers up-to-date, 
consider doing rounds of Send and Receives.  A round would consist of every team member doing a 
Send/Receive twice. Each team member should wait to do their second Send/Receive only after 
everyone else has done their first Send/Receive.  In this way, it is more likely that everyone will get 
everyone else’s changes. 

4. Be Careful when using multiple USB flash drives or other destination 
locations. 

Some changes and progress data can be “lost” for a while if multiple Send/Receive destinations are 
used. Changes and progress data on a second USB flash drive will not get shared with others in a 
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timely fashion.  Those changes will eventually make it to the rest of the team if a different USB flash 
drive or shared folder is used by the same user at a later time.  However, this delay in sharing 
changes to the text and progress data can lead to merge conflicts, and teammates waiting 
unnecessarily for permission to do their tasks. 

5. Global Changes 

Special care should be taken when using Paratext tools or features that can change the text in more 
than one book.  These tool features include spell checking with the Wordlist tool or any other spell 
checking method, Biblical terms renderings, parallel passages tool, Basic checks, or Find and 
Replace. It is recommended that anytime you know that you will be making a large number of global 
changes that all other team members stop editing the text until you have finished.  Then you do a 
Send/Receive followed by the rest of the team. Then you do a Send/Receive again to get everyone 
else’s changes.  

6.  More security 

If you need greater data security, consider using a VPN.  How to configure Paratext to work with a 
VPN is described in Paratext Help. 

 4. Reviewing Text Changes 
Through the Send/Receive process, the repository for a project on your computer will be accumulating 
a history of information about changes made to the text. Paratext can show you these changes. 
Sometimes two or more users change the same bit of text creating conflicting changes. Paratext can 
show you those conflicts and gives you tools for resolving them. There are three ways that you can 
see changes to your project. There is a special fifth way to see changes, but they only show changes 
that resulted in conflicts. Viewing and resolving merge conflicts will be covered last in this section. 

4.1. Compare Versions feature  
 

● From the Project menu, select Compare Versions 

A text comparison window will open displaying two panes of text for the selected project. By 
default, the left pane is used to display the newer copy of the text, and the right pane to display 
the older copy.  
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You can select which project to display in each pane using the drop-down arrow at the end of 
each project name. Hover over the project copy (version) of the text you want to  display. 

 

Click on that version of the project and Paratext will change to that version 
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Paratext will highlight differences between the two texts using one of three schemes (the 
Green/ Red Highlight, Underline/Strikethrough, or Underline/Superscript scheme can be 
selected from the View > Change Display Style menu). You can navigate to the next or 
previous difference using the arrows in the Compare Texts toolbar.  

4.2. View History for Verse(s) feature 
 

● Right-click inside a verse (or select multiple verses and right click on the selection) and 
select the option to View history for verse(s). 

 

A text comparison window like the one above in section 4.1 will open which compares the 
current text for the selected verse with a previous version of the verse text. It can be 
customized in the same ways as described above. 

4.3.     View Project History feature 
● From the Project menu, click on Project History 
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The Project History window will open. It displays a list of the project copies stored in the 
repository for the selected project. For each copy (or version) of the project the date, time, user 
name, and list of changed books are displayed. A user may have also added a comment to a 
particular point in the project history. The change summary presents a list of books together 
with the number of modified chapters and verses found when comparing the selected text 
revision with the previous event in the project history. 

 

Using the drop-down list, you can choose to show: 

● all changes in all books 

● changes in the current book 

● changes in the current chapter 

● changes in the current verse 
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If you click on one of the book abbreviation links, Paratext will automatically launch the 
Compare Texts tool. This tool is described above in section 4.1. 

4.4. Review Recent Changes feature 
 From the Project menu, select Review Recent Changes 
 

       This option is only available to an administrator. 

 
The Recent Changes dialog window will open. It shows a list of books changed by each 
user within the last 30 days.  

Clicking on the name of a 
book in the list will launch 
the Compare Texts tool 
with the left and right 
panes configured to show 
changes for the selected 
book.  
 
You can see more detail 
about changes by clicking 
on the down arrow and 
expanding the view for a 
specific version of the 
project. 
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You can undo the changes made to one or more books by placing a tick in the corresponding 
checkbox in the undo column, and then clicking on the Undo Selected Changes button.  

 

 

The Changes Since filter on the bottom of the dialog box will default to the current date.  If the 
changes that you are interested in happened at an earlier date, you can change the date by 
clicking on the drop down arrow and changing it.  

 
 4.5. Handling merge conflicts 

Sometimes changes produce merge conflicts during Send/Receive. (Basic information about merge 
conflicts and tips for avoiding them was discussed in section 1.4 What is a merge conflict.) Paratext 
has features just for seeing the changes that produced conflicts, and that allow you to choose which 
change you want to keep.  These features are centered on the merge conflict notes that Paratext 
automatically places in your text when it encounters a conflict.  

 

At the time  Paratext is processing a conflict it does three things: 1) it picks the changes made by one 

Back to the top 

Paratext 8/9 Project Sharing Manual - v 1.0 - October 2020 

Page: 26 



person to keep in the text, 2) the changes made by the other person are stored in a conflict note (a 
special type of Project Note),  and 3) attaches the note to the verse with the conflict. This conflict note 
then needs to be reviewed and resolved, usually by the Administrator. 

 

Immediately after a Send/Receive is completed, Paratext displays a Changes Sent and Received 
report  dialog.  If a merge conflict occurred during that Send/Receive then there will be an alert 
informing you that there were x number of conflicts. You can click on the link Open unresolved 
conflict notes list window to go to a list of the conflict(s) and view the conflict(s) and optionally 
resolve the conflict(s).  (The procedure for resolving conflicts is below in this section).  If you are 
unable to resolve the conflict(s) immediately after the Send/Receive then Paratext has two other ways 
to open a conflict note: 1) click on the conflict note flag in the text, or (2 open a conflict note list. Both 
or these ways of viewing conflict notes will be described later in this section. 

 

 
 Resolving a Send/Receive merge conflict 

A conflict note will show the two changes, the one Paratext accepted and the one it rejected. The note 
flag is a triangle with an exclamation point inside (like a highway hazard sign).  They will look like this 
in your text: 

Click on the conflict note flag to open the note. 
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If you open the drop down list by Accept, Paratext should offer you three choices. To accept the 
change it accepted (making no change to the current text); to reject the change it accepted, and 
accept the change it rejected; or to merge the two changes.  
 

You could choose any of these three options, or you could close the note and manually edit the text. 
After resolving the conflict, you can click “Resolve” to resolve the conflict note, so it no longer shows 
up as needing attention. 

 Opening  conflict notes list 

If the project has several conflicts, you can display the conflict notes in a notes list, by clicking Open 
conflict notes in the project menu.  
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Then you will see all the conflict notes together and can process them in order. 

 

If your project has a large number of conflicts, this is usually a sign that either permissions where not 
handled well, or procedures the team uses for doing Send/Receives needs improvement. Review the 
steps listed in the troubleshooting section at the end of this document for possible improvements to 
your team’s procedures that will reduce the number of merge conflicts generated by your team. 

 5. Send/Receive Maintenance 
 5.1. What project data is being shared by Send/Receive? 

The following components of the project are shared using Send/Receive: 

Major Components: 

● Project translation text (including which books are included in the project) 

○ project history 
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● Project users information 

● Project properties (including inventory data, quotation rules and so on) 

● Language settings (language name, language code, custom keyboard, etc.) 

● Scripture reference settings 

● Biblical terms renderings (Project Biblical terms list, Bible terms rendering discussion 
notes) 

● Wordlist data (spelling status, spelling discussion notes hyphenation, morphology) 

● Project notes 

○ comments 

○ note assignments 

○ note status 

○ custom note tag information 

● Project Plan  

● Project progress and assignments information 

○ Status of the basic checks 

○ Denied list items 

Minor or optional Components: 

● Any files in the shared folder (If the shared folder does not exist, you must create it in the 
project folder. It must be named “shared”, and it must be all lower case.)  

○ Note: If you do not have a fast internet connection, putting large files in the "shared" 
folder may cause you and/or other team members to not be able to successfully 
Send/Receive. 

● Files in the project folder with specific extensions (such as.txt or .ini. Including 
autocorrect.txt) 

● Figures (low-resolution versions, stored in the figures folder) 

● Project interlinearizer data  (such as glosses, and text alignment information) 

● Settings or adjustment files for Export draft PDF (stored in the PrintDraft folder) 

● Customizations to the stylesheet or project canon 

● Optionally layouts, Biblical term filters and text collections created by an Administrator. 

● Bible module specifications 

● Derived translation status information 

● Files which plugins have saved to the project 
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● TECkit mapping files in the project folder (files with extensions .tec or .map) 

● CC Table mapping files in the project folder (files with the extension .cct) 

Paratext creates a series of XML files in your project folder which store data for some of the 
above project components. Do not delete these files (or edit them outside of Paratext) - doing 
so is very dangerous. If a file is deleted from one computer, the Paratext project sharing 
software will understand this as a request to delete the file on all computers in the project 
when a send/receive is completed. 

5.2. What project data is not shared by Send/Receive? 
As needed, Paratext creates a folder named "local" within your Paratext project folder to contain items 
which will not be shared. For example, when inserting an illustration using Insert > Figure, Paratext 
copies the original (often high-resolution) image file to the "local" folder, and creates a low-resolution 
copy in JPG format within the "figures" folder. 

● Settings which would cause a problem when moving to another computer (for example, panel 
location, panel size, zoom setting, column widths, and splitter position). These settings could 
be a problem if the user is going from a computer with one (or more) large monitors to one with 
a small monitor. 

● Send/Receive settings for the projects on which you have done a Send/Receive. These 
settings, and related settings, would keep projects from being received on the new computer. 

● The time and date of the last help update. 

● The time and date of the last release check 

Other Paratext-related applications, such as Publishing Assistant, may create additional folders within 
your Paratext project folder which will not be shared by Send/Receive. 

5.3. Who can make changes to different types of project data? 
The following table lists each of the project roles together with what types of changes they are 
permitted to do. (In the case of the Observer role, no changes are permitted. Only viewing the text is 
permitted.)  Besides the main activities of viewing, editing the text, project notes, and project 
properties, there are many other activities that require permissions, these are listed in the Project 
Sharing Manual Appendix. 
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Action Roles Who Can Perform 

View text: Observer, Consultant/Reviewer, Translator, 
Administrator 

Edit text: Translator, Administrator 

Add or update project notes: Consultant/Reviewer, Translator, Administrator 

Edit project properties: Administrator 

Edit and send other project data: 
(Biblical terms, wordlist, interlinearizer, project progress etc.) 

Consultant/Reviewer, Translator, Administrator 

http://paratext.ubs-translations.org/about/pa
https://docs.google.com/document/u/0/d/1n2NTQGq0gzHM34Qd2JYpX9hwV5rVacRUtk1m5WMH1y4/edit
https://docs.google.com/document/u/0/d/1n2NTQGq0gzHM34Qd2JYpX9hwV5rVacRUtk1m5WMH1y4/edit


 

Note (translators changing editing assignments): A translator cannot add or remove 
people from a project or change their role. Under normal operation a translator would not 
change editing permissions for a book or a chapter. However, there will be situations when 
a translator is out of internet or USB contact with the administrator but has a legitimate need 
to start editing some new material not previously assigned. For this reason Paratext does 
allow a translator in an exceptional situation to change the book/chapters assigned to them. 
When this is done Paratext displays a warning that this is an unusual practice and that a log 
entry documenting that they are overriding the assignment will be created. 

5.4. Understanding the flow of changes 
Data is shared between user’s repositories one-by-one.  When you do a Send/Receive to the Internet, 
USB flash drive, or shared folder, you will not receive any changes done by team members who have 
not yet done a Send/Receive.  This is why you will often have to do a Send/Receive twice, if you need 
to give your changes as well as receive the changes from another team member. 

 

5.5. Managing project users 
These operations can only be done by an Administrator on the Administrator's computer, and require 
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Change editing assignments: Administrator, Translator (in special circumstances see note 
below),  



Internet access.  If you are working in an area without Internet access or access is blocked then you 
can add team members as Guest Users.  The guide for the User permissions dialogue describes 
how to do this.  Also look at the following topics in Paratext Help:  What are the limitations of Paratext 
for guest users?, and How do I make a guest user a registered user?. 

 
To add a user to a project: 

1. Click in the window of your project, to make it the active window. 
2. Click on the Project menu, go to Project Settings, then click on User Permissions. 
3. Click on the Add User button. 
4. Enter the Paratext Registration Name of the new user and click OK. 

   You must spell the name exactly as it appears in the user's official registration. 

5. Click OK in the dialog box notifying you that the user has been added. 
6. Click Change Role beside the new user’s name. 

7. Select the new user's role from the pop-up list. 

8. The pop-up dialog box will close. 
9. Click the OK button to continue.  
10. Paratext will automatically access the Internet and add the user to the Paratext registry site. 
11. A reminder appears telling you that you must now perform a Send/Receive. Click OK. 

12. The Send/Receive Projects dialog appears. Click Send/Receive button to share the 
updated user/role information with the team. 

To remove a user from a project: 

1. Click in the window of your project, to make it the active window. 
2. From the Project menu, hover over Project settings 

3. Click on User Permissions 

4. Click Remove beside the name of the user.  
5. Click Yes to confirm the deletion. 

6. Click OK to close the Users, Roles and Permissions dialog. 

7. A reminder appears telling you that you must now perform a Send/Receive. Click OK. 

8. The Send/Receive Projects dialog appears. Click Send/Receive to share the 
updated user/role information with the team. 

To change a user's role: 

1. Click in the window of your project, to make it the active window. 
2. From the Project menu, hover over Project settings 

3. Click on User Permissions 
4. Click Change Role… beside the new user’s name. 

5. Select the user's new role from the pop-up list. 

6. Click OK to to continue. 
7. Paratext will automatically access the Internet and add the user to the Paratext registry site. 
8. A reminder appears telling you that you must now perform a Send/Receive. Click OK. 

9. The Send/Receive Projects dialog appears. Click Send/Receive to share the 
updated user/role information with the team. 
 

Note: The project administrator can also change user roles in the Paratext registry in 
their web browser, if they are away from their computer. They can go to 
https://registry.paratext.org, log in, find the project and go to the members tab. To 
change a user’s role, they can open the list at “View profile” and choose “Change 
role”. 
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To re-assign tasks in the Project plan to a different user 

The Administrator can do this in the Assignments and Progress dialog. If you switch the view to All 
Tasks, you can see each task and who is assigned to it. You can open the drop down list for a task 
and select a different user.  For more information see Project Sharing Manual Appendix or search 
under “assign tasks” in Paratext help. 

To change the Administrator for a project: 

A project can have more than one administrator. If there are multiple administrators, they should be 
careful to communicate with one another to avoid duplicating or making conflicting changes to the 
members roles or to the project plan. But if needed, a second user can be made an administrator, by 
changing their role in the User Permissions list. 

An administrator cannot change their own role. But they can set another user as administrator, and 
that new administrator can then change the role of the first administrator.  
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6. Troubleshooting 
6.1. How do I fix a corrupted project text? 

If your project text appears to have gotten messed up on various computers after using Send/Receive, 
perhaps due to incorrect editing permissions and resulting in a large number of merge conflicts, the 
following steps will help you to fix the problem. 

  On each non-Administrator computer sharing the project: 

1. Perform a Send/Receive for the selected project. 

2. Do not do any further editing until you hear again from the Administrator. 

 
   On the Administrator's computer: 

1. Perform a Send/Receive for the selected project. 

2. Review the text to fix any problems and bring the text to the desired state. If there are 
merge conflicts, follow the instructions provided in "Resolving a Send/Receive Merge 
Conflict" (above) to resolve these. To review and resolve any other changes to the text, 
use one or more of the methods described in "Reviewing Text Changes" (above). 

3. Perform a Send/Receive for the selected project. 

4. Ask all other users to perform a Send/Receive for the selected project, and confirm that 
they can now continue editing. 

6.2.  How do I restore a project to a repaired computer or put it on a 
new computer? 

Note: You should not restore the project to your computer from a zip file backup               
or manually copy the project files to your computer and then rejoin project sharing,              
since this may result in numerous merge conflicts, which the Administrator will            
have to resolve. The procedure given below is the recommended method for            
putting your project on a new or repaired computer. 

 

There are at least three situations when you might need to restore your project on a computer after 
project sharing has been set up and working: 

1) You buy a new computer,  

2) You had to have your hard drive replaced or other major repairs done to your computer,  

3) You had to reformat your hard drive and/or reinstall your operating system.  

1. The first step will be to install Paratext on the new or repaired computer.  You can download 
the Paratext installer from the Paratext website: https://paratext.org/download/  

2. Next start Paratext and fill in your user information. As Paratext starts it should connect to the 
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Send/Receive server and download all projects that you have a role on.  

Note:  It will only be able to do this automatically if your computer was connected to the 
Internet at the time. What you do next depends on the destination you normally use for 
Send/Receives. 

 
Destination Internet: 

3a)   If your computer was not connected, connect it to the Internet 

4a)   Next do a Send/Receive and Paratext will copy and install your project files like when you first 
received them. (See: Initial Send/Receive for the other team members section above and follow the 
instructions appropriate to your role on the project.)  

 
Destination USB thumb drive or Shared folder: 

3b)   Insert the USB thumb drive or make sure you have access to the shared folder, whichever is 
appropriate for you. 

4b)   Next do a Send/Receive and Paratext will copy and install your project files like when you first 
received them. (See: Initial Send/Receive for the other team members section above and follow the 
instructions appropriate to your role on the project.)  

6.3.  I have a poor quality Internet connection. Can I still use 
Send/Receive? 

Internet access is not needed to use Send/Receive if the users you are sharing with are working in the 
same location, or meet together on a regular basis. You can use a USB drive or network shared folder 
to share project(s). In this scenario, it is also possible for one member of the project team (likely the 
administrator) to Send/Receive using the Internet server periodically when stable access to Internet 

is available. For some teams this may mean traveling to another location that has cell phone reception 
or that has an Internet cafe  (For more ideas of how to overcome the lack of a good Internet 
connection, see the Project Sharing Manual Appendix and the sections of this document Sharing one 
project to multiple destinations, and Consider Paratext Lite on an Android tablet or Smartphone).  

The speed of the Internet connection is not as important as its stability. It is more important that the 
connection remains active and reliable during the Send/Receive process than that the process takes 
place quickly. However, the initial sending or receiving of a shared project may take a long  time to 
complete on a very slow connection. Subsequent Send/Receive operations will not normally take as 
long because Paratext only sends information about what has changed in the project data since the 
last Send/Receive was performed. Be careful with adding a large number of figures to the project, or 
placing files in the "shared" folder (see "What project data is being shared by Send/Receive?") If you 
are using Send/Receive over a slow Internet connection, consider keeping your project as small as 
possible by limiting the number of pictures in your text and not including any large files in the shared 
folder.  

Another strategy would be to do your Send/Receives late at night when demand for the Internet is 
lower.  While you cannot set a specific time that Paratext is to do a Send/Receive, the Send/Receive 
scheduler can be set to do a Send/Receive one or four hours after you finish work for the day.  (See 
the section 3.3 Scheduling automatic Send\Receives) 
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6.4. Can I use other synchronization software and Paratext 
Send/Receive together? 

It is dangerous to use other synchronization software to keep your my Paratext projects folder up-to- 
date on two different computers I work with. It is highly likely to cause problems. It is very important 
that you omit the Paratext projects folder (usually C:\My Paratext 9 Projects) from any other software 
synchronization setups you have established. This would include file streaming software such as 
Google Drive, Google File Stream, Microsoft One drive, DropBox and any other software that 
automatically backs up your data to the Internet/Cloud.  Each individual Paratext project folder 
contains a repository folder named ".hg" which should NEVER be removed, or manually modified in 
any way. Changes to project data on each computer are stored within this repository in a way that an 
external synchronization process will not properly recognize or maintain. 

You should NOT use Mercurial software outside of Paratext to synchronize or share project data, or to 
operate on your Paratext repositories. This can also be very dangerous and should only ever be done 
by a trained supporter or Paratext developer for support purposes only. 
 

6.5. I do not have Internet access, how can I add a user to my project? 
Adding users requires that the administrator’s computer have Internet access. If you do not have 
Internet access, then you can add someone as a Guest user.  The guide for the User permissions 
dialogue describes how to do this.  Guest users are limited and cannot do everything a regular user 
can do.  To learn about these limitations see: What are the limitations of Paratext for guest users? in 
Paratext Help. In most cases, Guest users should be registered as regular users as soon as is 
convenient. To learn how to do this see: How do I make a guest user a registered user? in Paratext 
Help. 

6.6. I think sometimes my changes are not shared with everyone. 
What can cause this? 

One way that changes can seem to not get shared is if you use multiple Send\Receive destinations 
and do not eventually share the changes on one of those USB flash drives or shared folders with the 
computer that shares the project with the Paratext server on the Internet. You should have organized 
procedures for using multiple Send\Receivers to avoid some changes being on a seldom used USB 
flash drive in a forgotten desk drawer or someplace.  Eventually, those changes will be shared with 
the rest or the team and the Paratext server through the other destination devices being used, but 
because they were delayed in reaching the other users, the likelihood of conflicts will be high. 
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